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Preface

This User Guide is been implemented by Boot & Work, Satarking
under the namelndustrial Shields.

Purpose of the manal

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience
This User Guide is intended for the follogiaudience:

Persons in charge of introducing automation devices.
Persons who design automation systems.

Persons who install or connect automation devices.
Persons who manage working automation installation.
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& Warnings:

1 Unused pins should not be coected. Ignoring the directive may damage the
controller.
1 Improper use of this product may severely damage the controller.
WSTSNJ (12 GKS O2yGNRffSNDRa ! aSNJ DdZARS NB3IAIF NR
f Before using this product, it is the responsibility of the use¢ NB I R G KS LINRB RdzOi
Guide and all accompanying documentation.
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Application Considerationsand Warranty

Read and Understand this Manu

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESSIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESSIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standardst hat apply to the combination of products
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

1 Systems, machines, and equipment that could present a risk to life or property.

T Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

9 Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customerdés request, | NDUSTRI AL SHI ELDS v
certification documents identifying ratings and limitations of use that apply to the

products. This information by itself is not sufficient for a complete determination of the

suitability of the products in combination with the system, machine, end product, or

other application or use.



Disclaimers

Weightsand Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in

determining suitability and does not constitute a warranty. It may represent the result of

| NDUSTRI AL SHI ELDS6s test conditions, and t he
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS

Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.



Warranty and Limitations of Liability

Warranty

I ndustri al Shieldsés exclusive warranty is that
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANABILITY, NON-
INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE PRODUCTS.
ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE
REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONISBLE FOR WARRANTY,

REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL

SHI ELDS6S ANALYSI S CONFI RMS THAT THE PRODUCTS \
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO

CONTAMINATION, ABUSE, MISUSE, OR INAPPROPIATE MODIFICATION OR

REPAIR.
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INDUSTRIAL SHIELDS

1 General Description Wi-Fi & Bluetooth CONTROLLER

1.1 Zone- Nomenclature

The nomenclature shown in this point will be used in the whole User Guide, so it is
important to understand this nomenclature.

The nomenclature to differentiate the zones is based on the Alphabet, being A the
shield from below and B the shield from above.

B ZONE itgm |
A ZONE yummzen |

A ZONEL fmregm |
B ZONEI AT |

1 The inputs in the zone B are named 10.X, being X any number suitable in the
Shield. Outputs are named as Q0.X and relays as R0.X



1.2 Zone Distribution

ZONE A = ZOMEB

L | T
Communication Relay Shield
1.3 AZone Features

Shield A Zone

(1x) Ethernet

(1x) USB

(1x) 12C

(3x) TTL

(1x) RS-232

Communication | (1x) HALF/FULL Duplex RS-485

Shield (1x) SPI external Port

(1x) RTC

(1x) uSD Socket
(1x) WiFi & BLE




1.4 Mechanical dimension

CONECTABLE PLC ARDUINO 24Vcc M-DUINO

MODEL TYPE

WiFi & BLE Controller General Spec.

Fuse protection (2.5A)

Input Voltage 12 to 24Vdc Polarity protection
| max. 1.5A
Size 101x119.5x70.1 101x119.5x119.3
Clock Speed 16MHz
Flash Memory 256KB of which 8KB used by bootloader
SRAM 8KB
EEPROM 4KB

Communications

12C 7 Ethernet Porti USB1 WiFi &BLE T RS4851 RS232 -- SPI

1 (1x) Rx, Tx (Arduino pins)

Max232-Max485-W5500-ESP32

USB consideration!

Only meant for uploading or debugging, not always connected

as a serial in a project!

Cannot be working in a final
application

An/Dig Input 10bit
(0-10Vcce)

0to 10V
Input Impedance: 39K
Separated PCB ground

Digital Isolated Input (24vcc)

7 to 24Vdc
I min: 2to 12 mA
Galvanic Isolation

* Interrupt isolated Input HS
(24Vcce)

7 to 24Vdc
I min: 2 to 12 mA
Galvanic Isolation

Analog Output 8bit
(0-10Vcce)

0 to 10Vdc
I max: 20 mA
Separated PCB ground

Digital Isolated Output (24Vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay

Imax 24Vdc: 410 mA

PWM lIsolated Output 8bit
(24Vcc)

5 to 24Vdc
I max: 70 mA
Galvanic Isolation
Diode Protected for Relay

Relay Output

I max: 5A
V max: 24VDC / 230VAC




Expandability | 12C - 127 elements - Serial Port RS232/RS485/WiFi/BLE

* By using this type of signal can no longer use Digital signal (24Vdc)

| B < 7

1.5 GeneralFeatures




2 Technical Specifications:

2.1 General Specifications:

Item

M-DUINO B ZONE

Power supply

voltage DC power supply

12 to 24Vvdc

Operating

voltage range DC power supply

11.4 to 25.4Vdc

Power
consumption DC power supply 30VAC max.
Power supply 24vdc
External voltage
power supply Power supply 700Ma

output capacity

Insulation resistance

20MY min.at 500Vdc between the AC terminal

Dielectric strength

2.300 VAC at 50/60 Hz for one minute with a leakage current of 10mA max. Between all the
external AC terminals and the protective ground terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 45°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 4659 max.

2.2 Performance Specification:

Arduino Board

ARDUINO MEGA 2560

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform composed of a
programmi ng | angu a g bttp:/afdsiro.ctieh/ButorialfHomePdue CoO .

Microcontroller

ATmega2560

Flash Memory

256KB of which 8KB are used by the bootloader

Program capacity (SRAM) 8KB
EEPROM 4KB

Clock Speed 16MHz

Clock Speed 16MHz



http://arduino.cc/en/Tutorial/HomePage

3 Precautions

Read this manual before attempting to use é&Fi & BLEPLCand follow its descriptions for
reference during operation.

3.1 Arduino Board

TheMDUINO PLC ARDUINO ETHERNET & WIF18RBIS ANALOG/DIGITRLUSrcludes
anArduinoMegaBoard as controlleand a ESP32 Dev programmable chip as-&i\&iBLE
gateway

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautmns

The user must operat®i-Duinoaccording to the performance specifications described in this
manual.

Before using théViIDUINO PLC ARDUINO ETHERNET & WIF1L8RRI(E ANALOG / DIGITAL
PLUSunder different conditions from what has been specified in thanual or integrating

into nuclear control systems, railroad systems, aviation systems, vehicles, combustion systems,
medical equipment, amusement machines, safety equipment and other systems, machines,
and equipment that may have a serious influenceieed and property if used improperly,

consult your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics othe Ethernet/WiFi/BLEontrollerare sufficient for the systems, machines,

and equipment, and be sure to provitlee systems, machines, and equipment double safety
mechanisms. This manual provides information for programming and operatingEhéNO

PLC ARDUINO ETHERNET & WIFI®RLEBs ANALOG / DIGITRLUS

4 Software interface

Industrial Shields PLC are pragimed using Arduino IDE, which is a software based on the C
language. They can also be programmed using directly C but it is much easier working with
Arduino IDE as it provides lots of libraries that helps in the programming.

Industrial Shields providdmards for programming the PLCs much easier. Basically it is no
needed to define the pins and if that pins are inputs or outputs. Everything is set up
automatically if using the boards.

In order to install Industrial Shields boards, these are the stegisntust be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to have always the latest version).



Steps:

1. Open Arduino IDEndgo to: &File-> Preferenceslocated in the top left corner.

Preferences X

Settings  Metworl:

Sketchbook: location:

C:\Users\Albert\Documents\Arduing Browse
Editor language: English (English) ~ | (requires restart of Arduino)

Editor font size: 15

Interface scale: Automatic | 100 5 [%  (requires restart of Arduino)

Show verbose output during: [ compilation upload
Compiler warnings: None

[CIpisplay line numbers

[C]Enable Code Folding

[ Verify code after upload

[[Juse external editor

Check: for updates on startup

Update sketch files to new extension on save (pde -> .ino)

Save when verifying or uploading

Additional Boards Manager URLs:  http:/fapps.industrialshields.com/main/arduinoboards package_industrialshields_inde: [

More preferences ca ed directly in the file
:\Users\Albert\AppData\Local\Arduino15\preferences. et

s not running)

Ok Cancel

2. In Additional BoardManagerURLs write théollowing:

http://apps.industrialshields.com/main/arduino/boards/package industrialshields _index.json

3. Press OK to save the changes.

4. Goto: Tools>. 2 | NI Boards Manager

eetch_mari6a | Arduin 160
File Ecit Sketch Tools Help

Auto Format Cul+T
Achive Sketch
Fix Encoding & Reload

Serial Monitor Ctil+ShiltsM
Serial Plotter Cul+Shiltsl

WAFi101 Firmware Updater

Boarck "M-Duino family” |
Inchustral Steelcls: “W-Duin 58+ 1
( Port
1T ¥ GetBoard Info Arduino/Genuino Uno
X Programmer: “Artkino 23159 | Ashino Duemilanove or Diecimila

Arduino Nano

Asduino/Genuano Mega of Mega 2560
Asduino Mega ADK

Arduino Leonardo

Archino Leonardo ETH

Asduino/ Genano Micro

Arduing Esplora

Archino Mini

Arduino Ethernet

Bum Bootloader

Arduino Fio

Ascuino BT

LilyPad Arduno US8
LilyPad Archino

Archuing Pro of Pro Mim
Arduing HG or older
Aschino Robat Control
Arduino Robot Motor
Arching Gemma

Addatruit Cireuit Playground
Arduino Yun Mini
Archin Incustrial 101
Linino One

Arduing Uno Wit

Indusinal Shiekds boards
Asdbox family
* | M-Duino family


http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

5. Search fodindustrialshields on the browse.

€ Boards Manager X
Type All ~ | lindustrialshields
industrialshields ~

Boards included in this package:
ARDBOX family, M-Duino family.
Online help

More info

~ | Install

Close
6. Click install (selecting the latest version).
Following thesesteps you will be able teee now the Industrial Shields Boards:

File Edit Sketch Tools Help

Aute Format coteT
Archive Sketch
shetch_mar! Fix Encoding & Reload

Serial Monitor Ctrl oShifteld
Sertal Plotter Col+Shiftel

WiFi 101 Firm wase Updater

Board: “Arduino Yiin' 3 Boards Manager.
L Ard L
Get Board Info. Bl A
-
Programmer: "Arduin as 157" o
fum Boatioader Archino Duemilanove or Diecimila

Arckano Nano

Archino/Genuino Mega o Mega 2560
Arckino Mega ADK

Arckano Leonardo

Arcuino Leonardo ETH
ArckanoGenuino Micro

Arckano Esplora

Arckino Mini

Arckano Ethernet

Arduine Fio
Archino BT

Arcuino Robot Control
Arckino Robot Motos
Arcuing Gemma
Adafruit Circuit Playground
Archine Yan Mini

no Industrial 101

Once it is selected the Ardbox Féyror M-Duino family an extra option will appear on Tools:

There, it can be selected the exact model for every fartmlyhis caseM-Duino 19R+



& Blink | Arduino 1.8.0
File Edit Sketch Tools Help

Auto Form at Cirl+T
Archive Sketch

Blink § Fix Encoding & Reload
Serial Monitor Ctrl+Shift+M
Serial Plotter Cirl+Shift+L

WiFi1101 Firmware Updater

Board: "M-Duino family" >

Industrial Shields: "M-Duino 19R+" 3 M-Duino 19R

Port e M-Duino 19R+

Get Board Info M-Duino 21

i M-Duino 21+

Programmer: "Arduino Gemma" .
M-Duino 38AR +

Burn Bootloader .
M-Duino 38R
M-Duino 38R+
M-Duino 42
M-Duino 42+

M-Duino 50RRA +
M-Duino 53ARR+
M-Duino 54ARA+
M-Duino 57 AAR+
M-Duino 57R
M-Duino 57R+
M-Duino 58
M-Duino 58+

Also there are some examples of programming in-BilExamples>M-DuinoFamily.
Furthermore there are@me extra libaries that can be found in Industrial Shields github.

https://qgithub.com/IndustrialShields/



https://github.com/IndustrialShields/

5 How to connect PLC Arduino to PC

Connect USB port from PLC to PC.

NOTE:
M-DuinoFamiy uses USBB cable.

Open Arduino IDE interface:

Selectindustrial Shields bads ->M-DuinoFamily

Select the correc-DuinoBoard
M-Duino 19R+

@ sketch_mar16a | Arduno 180 a  x
File et Sketch Tooks Help
[
Coteshiftsd
CuteshinteL
Boad by >
Incluswial Shields:“Arcbon Relay HF w) HIW RS- 232" 3 Abax Andlog
0 o | Ardbom Ansog HE
GetBowd Inlo Arcton Relay
§ . Ardbos Relay HF (legacy)
bbb fucane s 156 Ao Relay HE w/ HW RS-485
Bun Boattoater

& Archo Relday HF w/ HW RS-232

- Select correct port.

@ sketch mar16a | Arduino 130 - 8 x
File Eit Sketch Tools Help

ey se— e
Aschive Sketeh
e martf, e Encoding & Reload
Serial Monitor Corf+ShiftaM ~

T Potir Catestttal

VAR 101 Finmware Updater

Boaret "Arcbox lamily”
Industrial Shields: “Ardiox Analog™ >
Port §  senal port

7 GetBowdinfo COM13 {Ardhino Leonardo)

Programmer: “Archano as ISP
Bun Bootoader




6 How to connect PLC to power supply

- M-Duino FamilyPICs are 124Vdc supplied. IMPORTANT: The pol&&tNOT
REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

[romen v
u GND |

|—f 24Voo |

| I

- Suggested power suppliers

* Not recommended for industrial applicatioribhe =t
Jackconnectorneeds to be removednd use the live
and GND connectors. IL %



7 M-duino Family Pinout

7.1 A Zone connection
Base
(common unit)
A Zone
5 £
i) o
28] ¢ §
S € 5 b
25| € 5
=0 < [
SCL 21 12C/SS
SDA 20 12C/SS
RXO0 1 RX0/SS
TXO0 0 TXO0/SS
NC - Not Connected
NC - Not Connected
> 16 RX2(serial 2)
RX 17 TX2(serial 2)
Z- - RS485
Y+ - RS485
B- - RS485
A+ - RS485
PIN3 3 Arduino Pin
50 SO 50 SPI
51 SI 51 SPI
52 SCK 52 SPI
Reset | Reset SPI
Vin5 Vin5 5V
PIN2 2 Arduino Pin
GND - Gnd
GND - Gnd
24Vdc Power Supply

e

ARef
sQw
IORef
3.3Vdc
svdc
Gnd

SCL
SDA

]
@
S

==

Configuration Switch{see sectior8 for
configuring the communications
Enabling communications disables some
1/0s)

Communication Pins

Power supply connectors
(24vdce GND

SS: Chip Select pins. These pins can act as TTL, sortheyricdor the Chip Select pin of any device.

Base
(common unit)
A Zone
5 £
o
o=
£ 8 o S
S c = B
25| 3 =
=0 < (i
AREF AREF  |Arduino PIN
IOREF2 | IOREF2 |[Arduino PIN
IOREF1 | IOREF1 |Arduino PIN
7Vvdc 7Vdc -
GND GND GND
3.3vdc | 3.3vdc |Arduino PIN
GND GND GND
5Vvdc 5Vdc -
GND GND GND

=

OFF ON
SCL/I12.6
SDA/I25
Rx1/11.6
Tx1/11.5

Pin3/106
Pin2/10.5
D53(SD)
FD rs4ss HD
OFF ON

NC

NC
RTC SCL
RTC SDA




é ]
Y z3 W
L4 <ksY > |
B i2 CF g e
§ <€ Reser / UsBB “Frogram | £ l\s
B RTC Banery (CR#2D) "uSD Socket[J
Ethernet Audno / Power
Connector Reset button

*NOTE: Autoreset. Arduino mega has auto reset when using serial communication code. Set switch to OFF when using

USB progrenmer
connector

serial communication. When uploading code to Arduino Mega set switch to ON.

Autoreset



7.2 B Zone RelayShield)

B Zone I

o5 & RO.8

S o o c

s 2 c ]

Qc =] I3

S o ° c RO7

(@) < I

R0.8 37 Relay Out RO6

RO.7 38 Relay Out )

RO.6 39 Relay Out Relay Outputs

RO.5 40 Relay Out

RO.4 24 Relay Out RO.5
A0.2" 6 Analog Out
A0.1* 5 Analog Out
A0.0" 4 Analog Out RO.4

GND GND GND
Q0.2 6 Digital/PWM Out '@Ana[uu
Q0.1 5 Digital/PWM Out pragvae
Q0.0 4 Digital/PWM Out ’"nggi;aéfpw

GNDCOM - External Isolated Out Gnd ¢ .
24VCOM 5 External Isolated Out Vdc Analog Outputs (Switch
Configuration)
Digital/PWM Outputs
. (isolated)
Top Zone I

Led indicator 1/Os state

B Zone RO 3
o =
c o £ Relay Outputs
.g 5 5 5 R0.2
° =
<< £ 2
o S S
O }Lf w RO 1
Analog:
RO.3 25 Relay Out gjﬂf:""dc
R0.2 22 Relay Out gital:
RO.1 23 Relay Out 5 -24vae
GND GND GND Digral
10.5 57 Analog/Digital Input 5-24Vdc
10.4 56 Analog/Digital Input — &ND
10.3 55 Analog/Digital Input . 105 Analog/Digital Inputs
10.2 54 Analog/Digital Input 2 0.4
10.1* 3 Interrupt 1 In 2 103 .
()10.1 - GND 10.1 2 e 102 Interrupt Inputs (isolated)
10.0* 2 Interrupt O In E |-°_|,_ (0.1
-)10.0 - ND 10. o~ 100 . . .
0 GND 0.0 z \:h— (-)l0.0 Configuration Switch*
%Tﬁ ) offS (see section 8 to select the
8553 #4|ao2 correct configuration for
R *5%lao1
8g> zk(aoo outputs).
H 2 % §




See sectio to select suitable switch configuration for enable these connections.

8 Switch Configuration

8.1 A Zone:Communicatiorns

LEFT ZONE
Switch Analog Shield
ON | OFF
B ZONE
Pin 3/10.1 10.1 Pin 3
Pin 2/10.0 100 Pin 2
uSD & R885
D53(SD) - SD
FD R€85HD| HD FD
OFF ON
SCL /121
SDA /2.0
Rx1/11.1
Tx1/11.0
Pin3/10.1
Pin2/10.0
D53(SD)
FD RS485 HD
OFF ON

4.SCL/12. AALWAYATOFRPOSITIONDOnthe MDUINO PLC ARDUINO ETHERNET & WIFI &
BLEL9RI/Os ANALOG/DIGITRLUS ontrollerthis switchis not connected

3.SDA/I12.0 ALWAYRATOFRPOSITIONOnthe MDUINO PLC ARDUINO ETHERNET & WIFI &
BLEL9RI/OsANALOG/DIGITALUS ontrollerthis switchis not connected

2.RX1/11.12 ALWAYRATOFRPOSITIONOnthe MDUINO PLC ARDUINO ETHERNET & WIFI &
BLEL9RI/Os ANALOG/DIGITRLUS Controllehis switchis not connected

1.TX1/11.0 ALWAYRATOFAPOSITIONOnthe MDUINO PLC ARDUINO ETHERNET & WIFI &
BLEL9RI/Os ANALOG/DIGITRLUS Controll¢his switchis not connected



4.Pin3/10.1: ChoosindetweenPin3 or the input 10.1 If this switchis ON, it enablesthe 10.1
input anddisableghe Pin3. If this switchis OFFjt enablesPin3 anddisabled0.1

3. Pin2/10.0: ChoosindretweenPin2 or the input 10.0. If this switchis ON,it enablesthe 10.0
input anddisableghe Pin2. If this switchis OFFjt enablesPin3 anddisabled0.0

2. D53(SD):ALWAYRATOFFRPOSITIONOnaMDUINO PLC ARDUINO ETHERNET & WIFI &
BLEL9RI/Os ANALOG/DIGITRLUS ontrollerthis switchis not connected It allowsthe uSD
storage.

1. FDRS485HD: ChoosingbetweenFDor HF.If this switchis ON,it enablesthe HaF Duplex
(HD)option anddisableghe FD.If this switchis OFFjt enablesFullDuplex(FD)and disables
HD.

LEFT ZONE ore =

SWITCH ON OFF

NC - -

NC - - RTC SCL

RTC SCL RTC - RTC SDA

RTC SDA RTC -

1. RTC SDAhis switch enables the communication to communicate WthRTC
using 12C. Having this switch in ON mode it actives this communication,
whereas if it is in OFF mode it disables the 12C to reach the RTC.

2. RTC SCrhis switch enables the communication to communicate with the RTC
using 12C. Having this switeh®@N mode it actives this communication,
whereas if it is in OFF mode it disables the 12C to reach the RTC.

3.NCb2i O2yySOlGSR® ¢KAa agAlO0OK A& yz2i 0O2yy
if it is in ON mode or OFF mode.

4. NC:Not connected. This switchys2 & 02y ySOUSR (G2 FyeuKAy3I:
if it is in ON mode or OFF mode.



8.2 Relay Shield

B ZONE
SWITCH| ON | OFF
NC - -
Q0.2 | Q0.2| A0.2
Q0.1 | QO0.1]| A0.1
Q0.0 | Q0.0| A0.0

For the Relay Shield if a switch is set to ON, it can only act aal Qigiput. If it is set to OFF it
can only act as an Analog Output.

If it is desired to use a Digital Output the pin must be set to ON and the pin that will provide
this digital output is represented with Q0.X, being X any number of the tables above.

If it is desired to use an Analog Output the pin must be set to OFF and the pin that will provide
this analog output is represented with A0.X, being X any number of the tables above.

9 1/0Os 5V pins

TheMDUINO PLC ARDUINO ETHERNET & WIF18RBIE ANALOM@IGITAPLUSas

some of the Mega board pins available.e$&pins can be programmed according to Arduino
features such as 1/Os operating at 5V or any additional features present in the pins (for
example 12C communication in pins SCL and 2BAhis piis are directly connected to the
Arduino Mega board they are not as well protect as the normal inputs. These pins are mainly
meant to be used as prototyping.

The Arduino board available pins are summarized in the table belowdén tw access some
of the=e pins the configuration switch must be set to OFF position (see se®jtemd some
extra considerations must be taken in consideration when using these pins

M-Duino terminal Arduino pin Enable Arduino pin
SCL 21 Communication switch: OFF
SDA 20 Communication switch OFF
RX0 0
TXO0 1
RX1 19 DONO6T USE!
TX1 18 DONO6T USE!
MISO 50
MOSI 51




SCK 52

Pin 3 3 Communication switch: OFF

Pin 2 2 Communication switch: OFF

*IMPORTANTDoO not connect the terminals in the chart above to voltages highan 6\V.
These terminals provide direct access to the Mega board.

A part from the switch configuration there are some special conditions depending on these 5V.
Now it is going to be shown the considerations to operate with these pins.

9.1 12C pinsz SDA/SCL

Thel2C protocol is meant to work in a pulb configuration. A pulip configuration means
that when the pin is at rest (nothing connected to it) it always remH$GH value. In this case
it reads 5V when nothing is connected. The -pipliconfiguration is siblished by default in
these pins.

If it is meant to work them as a GPA@BV, it has to be considered that they are pulb
inputs.

*IMPORTANT: 12.5 & 12.6 are not puyl inputs although they are referred to the 12C pins
(switch configuration). Thersb & NXpdlSpNdrclitdthat is stablished in order to have the
same behaviour as the other inputs.

9.2 Serial 0z RX0/TX0

The Serial0 protocol can work also as a 5V pin. These pins should be used ultimately, only in
case that all the 5V pins are alrgaplerforming a function. This is because they are shared

with the USB interface. If using these pins, the USB communication cannot be working at the
same time. When the PLC is not installed, the USB communication is normally required for
debugging, uploadg and intercommunicating with thEthernet controller If using both
interfaces athe same time theArduino boardwill get blocked.

These pins are not stablished with a pytl or a puldown configuration. The state of these
pins isunknown. If these ims must be used, they require a pufp or a puldown
configuration. The Arduino board allows the pins to be set in aypudonfiguration. If not it
must be stablished an external pulp or pultidown circuit in order to correctly work with
these pins.

9.3 Serial 17 RX1/TX1

In the WiFi & BLEontroller, Serial 1 is used to communicate throughE$#3tegratedin
the MDUINO PLC ARDUINO ETHERNET & WIF18RBIOs ANALOG/DIGITRLUS

5hbao¢ [ {9 {9wL! [ ™

9.4  SPIz MISO/MOSI/SCK



These pins can only worls a 5V pins if the Ethernet protocol is not going to be used. As the
Ethernet protocol uses the SPI to communicate with the Arduino board, both behaviours
cannot happen at the same time as the Ethernet would not work.

These pins are not stablished with allpup or a pulldown configuration. The state of these
pins is unknown. If these pins must be used, they require aupudir a puldown
configuration. The Arduino board allows the pins to be set in ayputionfiguration. If not it
must be stablishedraexternal pullup or pultdown circuit in order to correctly work with
these pins.

9.5 Pin 2/Pin3

These pins are only referred to the input0I0.1. If the switch configuration is in OFF
position thepinsPin 2/Pin 3 will be available.

These pins are nattablished with a pullip or a puldown configuration. The state of these
pins is unknown. If these pins must be used, they require aupudir a puldown
configuration. The Arduino board allows the pins to be set in aygudonfiguration. If not it
must be stablished an external pulp or pultidown circuit in order to correctly work with
these pins.

10 A Zone Features: Communications & RTC & uSD

10.1 RS232



The Arduino Mega function code to access the2B&Eport in the MDuino is Serial2 (piri6
and 17 of the Arduino Mega).

FortheRHoH O2YYdzyAOF A2y LINRB(G202f GKSNB AayQi
matter the configuration of the switches to implement a-B& communication.

Using the boards of Industrial Shields, there library that simplifies the R&32
implementation.

10.2 RS485

For RS485 communication protocol the defined Arduino Mega pins are showed in the chart
below.

Function Arduino Pin
DI 14
RO 15
RE 11
DE 46

For the R&85communicationprotocol there is ont one switch that affects in this
communication. The R&5 protocol will be always enabled, the only switch that affects is the
2yS OFIf@i8R & 63 KA. J8s syitthOnakeLtlye choosing betweerdRS

Half Duplex or R&35 Full Duplex (R&2).

Using the boards of Industrial Shields, there is a library that diegpthe R85
implementation.

10.3 12C

12C communicatioDOES NOT REQUERRUIFUp resistorfor the M-Duino FamilyThe puHlup
resistor is already implemented in the PCB.

I2C commnication is configured by switches, so the switches must be configured in order to
enable the 12C communication.

To enable 12C the switches SCL/I2.6(12.1) & SDA/12.5(12.0) must be set to OFF mode. In this
mode the inputs are totally disabled and the B@ow enabled.

Industrial Shields does not provide any library to implement the 12C as it can be used the
standard library of Arduino called Wire.



10.4 SPI

The MDuino pins used for the SPI bus are summarized in the table below. For SPI bus MISO,
MOSI and GRQCK pins are common to all the connected devices to tiaulio, conversely,
each of the connected devices will have a single and dedicated SS pin.

Function M-Duino connection Mega board pin
MISO 50 SO 50
MOSI 51 SI 51
CLOCK 52 SCK 52
Reset Reset Resé¢
SS SCL/SDA/RXO/TX0/RXL/TXL/RX3/TX3/Pin2/P| 21/20/1/0/19/18/15/14/2/3

Check thewitch configuration at section ® enable SS pins.

10.5 TTL

M-Duino hasone TTLport, RXO/TXORX1/TX1s used for WFi and BLE communicatipd TLO
is accessed with the fiction Serial (pins 0 and 1 of the Arduino Mega).

10.6 Ethernet

M-Duino Ethernet port controller is based on w5500 IC, which is the compatible IC compatible
with Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino lisare compatible

with the M-Duino. In the MDuino, W5500 IC communicates to the Mega boaadSRI bus (SS
Arduino Mega pin 10

10.7 RTC

M-Duino RTC Module is based on 81307 Chip. This chip works with the 12C protocol
communication, so it is required to have enabled the 12Gqual.

4 switches have to be configured in order to enable the RTC features:

LEFT ZONE
SWITCH ON OFF RTC SCL & RTC SDA must be set to ON mode to enable
sg - - the 12C wires to the RTC. If they are in OFF mode, the
RTC SCL RTC . ' NRdAzZA Yy 2 62y QU O2YYdzyAOl 0S
RTC SDA RTC -
| Switch | Analog Shield |

gAlK



ON OFF

SCL/I2 2.1 SCL

SDA/I2.0 12.0 SDA

I2C must be enabled in order to commuatie with the RTC. See sectionl2C to enable it.

Using the boards of Industrial Shields, there Ibrary that simplifies th&TC implementation
called RTC.

10.8 uSD

The micro SD uses the SPI communication to interact with the Arduino Mega. The SPI protocol
is always enabled, as there are no switctiest configure it However there is a switch that
mustbe placed to ON mode in order to communicate with the uSD:

D53(SD): If this Switch is OFF, it enables the Chip Select of the microSD socket and disables
Q2.0. If this switch is ON, it enables the Q2.0 output. If the switch is in ON mode the microSD
Ol Ype&used.

The uSD socket is found in the TOP part of the communication Shields, so in the frontal part of
the PLC, it is required to open the plastic found in the frontal partthadocket is located
under the supply of the Arduino.

Switch Analog Shield
ON OFF
D53(SD) Q2.0 | D53(SD)

Using the boards of Industrial Shields, there is a library that simplifies the uSD implementation
called SDIt is the same as the Arduino library, with the only modification of using the pin 53 to
selectthe Chip Seleatf the uSD chip.



10.9 WiFi & BLE

The WiFiand Bluetooth integrated module consistsin a single 2.4 GHzWi-Fi and Bluetooth
combo chip designedwith the TSMCultra-low-power 40 nm technology.lt is designedto
achievethe best power and RFperformance showingrobustnessyersatilityandreliability in a
wide variety of applicationsand power scenarios.Someapplicationsare GenericLowpower
loT SensoHub,GenericLow-power loT DataLoggersaand MeshNetwork.

It isdesignedor Internet-of-Things(loT)applications.

10.9.1 GeneralSpecifications

Wi-Fi

1 802.11b/g/n

7 802.11n(2.4GHz)upto 150Mbps
Bluetooth

1 Bluetooth4.2 BR/EDMBLEdualmodecontroller
1 +12dBmtransmittingpower
1 NZIFeceiverwith -97 dBmBLEsensitivity

10.9.2 WiFi & Bluetooth Module Configration

In orderto configurethe WiFi& BLEModule,you mustconnectit to aPC.
Toconnectit youwill needamicroUSBo USBcable.

Theslot for the micro USBnput is locatedon the right sideof your equipment.

Toloadthe programinto the ESP33ou haveto installthe boardon the ArduinolDEsoftware
Goto File> Preferencesndinto AdditionalBoardsManagerURLsddthe next

URL https://dl.espressif.com/dl/package esp32 iexljson

*If you already have one URL put it next to the other separetedanya, like in the image
below.


https://dl.espressif.com/dl/package_esp32_index.json

Preferences

X
Settngs  Network
Sketchbook location:
C:\UsersUSER \Documents \Arduino Browse
Editor language: Engiish (Englsh) «  (requres restart of Arduino)
Editor font size: 13
Interface scale: M Automatic 100 T % (requires restart of Arduino)
Theme:

Default theme | (requires restart of Arduino)
Show verbose output during: [ | compilation [ upload
Compler warnings: None

[[] Osplay ine numbers

[JEnable Code Folding

[A verify code after upload

] Use external editor

[ Aggressively cache complled core

A Check for updates on startup

[ Update sketch files to new extension on save (.pde -> .ino)
4 Save when verifying or uploadng

Additional Boards Manager URLs: | o/boards/package _industriaishields_index.json, [Tt e pes e

ore preferences can be edited dreclly in the fie

C:\Users \USER \AppData Local\Arduino 1 5\preferences. txt

edt only when Aduro 5 rune

Nowyouare ableto installthe board.Goto Tools> Boards> BoardsManagerand searchby
ESP32.

Will appearthe esp32by EspressiSystemsinstallit.

Onceit isinstalledgoto Tools>Boardsand chooseESP3DevModule



& sketch_may17a | Arduino 1.8.0
File Edit Sketch Tools Help

Auto Form at Cirl+T
Archive Sketch
sketch_may17] Fix Encoding & Reload
. Serial Monitor Cirl+Shift+M
vold setup i .
Serial Plotter Crl +Shift+L
/7 oput v
WiFi101 Firmware Updater
' Board: "ESP32 Dev Module" 3 _ . A
Flash Mode: "QIO" 3 LilyPad Arduino
void loop( Flash Frequency: "80MHz" | Arduino Pro or Pro Mini
/7 PUt ¥ cpy Frequency: "240MHz (WiFi/BT)" s Arduino NG or older
Flash Size: "4MB (32Mb)" 3 Arduino Robot Control
t PSRAM: "Disabled” 3 Arduino Robot Motor
Partition Scheme: "Default 4MB with spiffs (1.2MB APP/1.5MB SPIFFS)" g CENEDEEnG
Upload Speed: "921600" 3 Adafruit Circuit Playground
Core Debug Level: "None" 3 Arduino Yin Mini
Port Arduino Industrial 101
Get Board Info Linino One
Arduino Uno WiFi
Programm er: "Arduino Gemma" 3 ESP32 Arduino
Burn Bootioader ® ESP32 Dev Module
ESP32 Wrover Module
ESP32 Pico Kit

Turta loT Node

TTGO LoRa32-OLED V1

XinaBox CW02

SparkFun ESP32 Thing

u-blox NINA-W10 series (ESP32)
Widora AIR

Electronic SweetPeas - ESP320

Theinternal connections between thESP32nodule and theArduino Mega are the following:

Arduino Mega Pinout ESP32 Pinout
5Vdc Vcce
GND GND
Tx1 (Pin 18) TxD
Rx1 (Pin19) RxD

WiFi and Bluetooth aralways enabled as there are no switches that configure it.
The WiFi and Bluetooth module ussriall for communication

More information: https://www.industrialshields.com/blog/industriathieldsblog-1/post/wifi-
bluetooth-module-esp32devkitv1-133



https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-bluetooth-module-esp32-devkit-v1-133
https://www.industrialshields.com/blog/industrial-shields-blog-1/post/wifi-bluetooth-module-esp32-devkit-v1-133

11 I/O technical details:

Digital Output Waveform:

[N o e——
v

DIGITALOUT

CH1 ¥ Z88m

DIGITAL OUT




Analog Out Turn On:

]

ANALOGOUT

ANALDG OUT




12 Typical Connections

DIGITAL ISOLATED INPUT

E GND (-)10.0
512124V 10.0

GND
@ POWER
12/24v B oemaw

Download the MDUINOG LAYOUT:
From: www.industrialshields.com

DIGITAL NO-ISOLATED INPUT

(-)10.0

o— 100

GND
g POWER
1224V

B owmamw

Download e MDUINO LAYOUT:

DIGITAL/ANALOG INPUT
(Digitaly

—0/07 0.7

GND
@ POWER
12/24v . J DIGITAL/ANALOG IN

Download the MDUING LAYOUT:
i From: www.industralshields.com




DIGITAL/ANALOG INPUT
{Digital with external
alimentation)

W 512124V 10.7
GND
GND
POWER
12/24v [ DIGITALANALOG IN
Download the MDUING LAYOUT:
i From: www.industriaishields.com
DIGITAL/ANALOG INPUT
(Analog)
010V
M 0.7
GND
@ POWER
1224V B DemALANALOG I
Downioad the MOLING LAYOUT:
i From: www.industrialshields.com
DIGITAL/ANALOG INPUT
(Analog with external
alimantation)
0-10v
@ 5112024V M 0.7
GND
GND
@ POWER
12124V [ DIGITALANALOG IN

Downioad the MDUING LAYOUT:



DIGITAL ISOLATED OUTPUT

Q/vde 51224V
!
COM () GND E’ A

ALWAYS
CONNECTED
Q0.0
GND -
POWER VoOUT=Q/Vdc
12/24V | DIGITAL OUT
Downlaad the MDUING LAYOUT:
From: www.indusiriafshiskds.com
DIGITAL NON-ISOLATED
QUTPUT
Q/ Vde
COM (-) @
ALWAYS
CONNECTED
Q0.0
GND -
E 3 POWER VOUT =Q/ Vvde
12i24v 0 owemaLour
Downfoad the MDUING LAYOUT: 5
From: www.industrigishields.com
DIGITAL / PWM ISOLATED
OUTPUT
* See the swifch
configutarion (ON)
Q/Vde 512124V E @
COM {-) GND
ALWAYS
CONNECTED
Q0.5
GND -
POWER VOUT=Q/Vde
1224V ' " DIGITALPWM OUT

Download the MDUINO LAYOUT:
i From: www.industrialshields.com i



DIGITAL / PWM

GND
&1 224V

POWER

NON-ISOLATED QUTPUT

Q/Vde
COM ()

Q0.5

DIGITAL/PWM OUT

Dc.:wnfnad the MDUINC LAYOUT:
From: www.industrialshields.com

* See the swifch
configutarion (ON)
ALWAYS
TN CONNECTED
VOUT = Q/Vde

ANALOG OUTPUT

* Analog Outs no led
indicator

GND

POWER

12/24v

ANALOG OUT

GND
AQ.5

* See the switch
configutarion (OFF}

N 0-10V

Download the MDUINO LAYOUT:
i From: www.industriaishieids.com



13 Connector details:

The connector inside the PLCs that mounts onR is MC 0,5/16-2,5 THT 1963502
from Phoenix contactViC0,5/106G-2,5THT

For 1/0O and power supplpere isa FKkMC 0,5/10STF2,5- 1881406connector from Phoenix
contact FKMC 0,5/16SF2,5

Connection details:

Article reference| MC 0,5/10G-2,5 THT|
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm

Article reference FKMC 0,5/16STF2,5
Rigid conduit section min. 0,14 mmz?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?2
Flexible onduit section max. 0,5 mm?2
14 Mech
Conduit section AWG/kcmil min., 26 anical
: : : Characteristics
Conduit section AWG/kcmil max 20



https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General

-  Dimension :

- DIN Rail mounting
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